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Release 3.2.366 

 

Core Module 

• There is a new option on the TOOLS�PARTS menu to browse all the sensor 

parts. 

• You can now add new WorkPlace Tech 5.8 Application files directly to a 

device or folder node by right-clicking in the Files tab and selecting 

NEW�WORKPLACE TECH 5.X APPLICATION  

• In the Enterprise Server Management (available only to companies with 

multiple related server installations), there are new User and License reports 

that combine the lists from all the servers. 

• An issue where deleted projects would show in the New Project Template list 

has been resolved. 

• If a node has any e-mails or tasks on it, the corresponding tab will be shown 

regardless of the View settings.  An icon will also appear next to the tab name. 

• When you drop or paste a file or e-mail to a node, the appropriate node and 

tab will be selected automatically. 

 

Design Module 

• You can mark individual drawing files with a Drawing State, such as 

Preliminary, Construction, As-Built, Submitted and Approved.  You can also 

display any of the Project Properties (which have been expanded) on a 

drawing, title page or title block. 

o There is a significantly expanded set of Project Properties available on 

the Properties tab when the root Designer node is selected. 

o There are new shapes in the Page Add Ins stencil that displays the 

Drawing State or a Project Property.  You can add these to your 

drawings directly or to your custom Title Block shape. 

o You can set the Drawing State value for a drawing using the Revision 

Notes tool.  This will update the text in each Drawing State shape on 

each page in the drawing (including those in a group, such as the Title 

Block shape; it will not, however, look any deeper than the first level 

of grouping) 

o The Project Property Labels will be updated automatically each time a 

drawing file is open.  You can also use the Revision Notes tool to 

update multiple files explicitly. 

• The SE – iPortal Import Sheet reports have been upgraded and moved to the 

main Reports tab list. 
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Release 3.2.363 

 

Core Module 

• There is a new version of the User and License Management Tool 

(ADMIN�MANAGE USERS AND LICENSES): 

o New, cleaner design with licenses and remote users on tabs 

o Export to Excel Utility 

o Request and change user passwords 

o View, add and remove remote users 

o Reset License Accounts 

• When editing Part Packages in the Parts Database Manager, points, labor and 

comments are now properly editable. 

• The xP Display module is now available in the Continuum (xP Modules) 

stencil to add to the Network Tree. 

• When using the Niagara R2 Convert Station Backups utility, the system 

assumes that Niagara is installed in the C:\Niagara folder.  You can specify a 

different path for the Niagara root folder in the Smartware Studio.ini file 

(located in C:\ProgramData\Smartware Studio\Config on Windows 7 or 

C:\Documents and Settings\All Users\Application Data\Smartware 

Studio\Config in Windows XP).  Add a section and entry such as: 

[Niagara] 

R2RootFolder=E:\Niagara 

 

Estimating Module 

• There is a new tool available from the Estimate menu that imports each Part 

Package from the database into a separate system in the estimate.  This allows 

you to use the Material/Update Parts to Database utility to validate the parts 

and find obsoleted and replaced parts and to run other reports. 

• Parts with no vendor specified were not being shown in the Material By 

Vendor summary table (they were included in all other calculations and 

reports).  This has been resolved. 

 

Design Module 

• The Designer Module/Design360 User’s Guide is available from the Help 

Menu (it will download automatically). 

• Many of the SE Visio shapes have been updated to fix minor discrepancies in 

point names and problems with auto-insert on certain point types.  The icons 

for all the stencil shapes have also been redone to be larger and more 

representative of the shape.  You may need to update the Parts Database and  

Clear and the Update the Design Project Database (from the Design Tools tab) 

to see all the changes correctly. 
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Release 3.2.362 

 

Core Module 

• There is a new Help menu command for sending an email to 

PartSupport@smartwaretech.com. 

• When importing a Network Tree from a Niagara R2 device, Lon Devices are 

no longer flagged with an incorrect part Number (Xenta 913) 

• The issue where the Job Number or Quote Number specified on New Projects 

created from a template does not get stored in the new project has been 

resolved. 

• The problem creating Multi-File System Libraries on Windows XP has been 

resolved. 

• The problem saving changes to the Project Group folder structure has been 

resolved. 

 

Design Module 

• The distance between the wires on both versions of the I/O Point Shape is now 

selectable. 

• The Auto Insert’s “Remove Empty IO” feature no longer resets properties of 

existing points. 

• The issue with the “Unable to Register Assembly / Regasm” message when 

opening a Designer drawing has been resolved. 

• Issues relating to the licensing of the new SE I/A BACnet and LON stencils 

have been resolved. 

• Issues relating the Smart Charts have been resolved. 

 

 

Release 3.1.358 

 

Design Module 

• There is a new Guide available on the Help menu: Upgrading from Designer 

Suite 2005 

• New versions of the Schneider Electric I/A BACnet and I/A LON controllers 

are available in two new stencils (SE IA BACnet and SE IA LON).  These 

shapes replace the previous versions in the older versions of the stencils. 

• The Insert Project Properties feature of the Valve, Damper and Air Flow 

schedules has been fixed. 

• A rare issue where a Valve, Damper or Air Flow schedule cannot be properly 

scanned by Designer because the Used Area of the spreadsheet is set as a 

range of full columns has been resolved. 
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Core Module 

• When working with WorkPlace Tech Application Files: 

o There should be fewer instances where WorkPlace Tech notifies the 

user that “WorkPlace Tech 5.x has updated Visio.  The Visio path 

settings have been updated.  WorkPlace Tech will attempt to restart 

Visio and continue.”  Also refer to the OTHER SOFTWARE tab in the 

TOOLS�OPTIONS settings when dealing with this issue. 

o You can now create a new, blank WorkPlace Tech application file 

from the NEW menu when right-clicking on a folder’s Files tab. 

o When opening WorkPlace Tech application files from within 

Smartware Studio, Studio will not remove its temporary files so that in 

the unlikely case that the modified WorkPlace Tech application files 

do not get copied back to the Studio project they can be retrieved 

manually with the help of our support team. 

• You can now restore deleted folders and items back to the Project and 

Network Tree from the Recycle Bin. 

• The Project Group tree will now retain the state of which folders are expanded 

(instead of expanding all each time the Open Project form is shown). 

• The Continuum Network Tree import has been upgraded to handle I/O 

Modules. 

• For distributed folders (e.g., custom templates and reports), you can now 

specify a list of files that should be removed from each workstation when the 

folders are synchronized.   

o Create a file named recall.txt in any distribution folder on the server.   

o In this file, list the names of the older versions of files (one per line) 

that were distributed that you want removed from the corresponding 

folder on each workstation. 

• You can now add custom items to the NEW menu that appears when you right-

click on a folder in a tree or in the blank area of a folder’s FILES tab. 

o The file should be named Custom Templates.xml and be stored in the 

Custom Templates folder on a workstation (and server, to distribute to 

all users).  Refer to the TOOLS�OPTIONS�DESIGNER tab and the 

ADMIN�DESIGNER MODULE MANAGEMENT�TEMPLATE FILES tab for 

more detail on these folder locations. 
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o The file should contain records in a format such as: 
<?xml version="1.0" encoding="utf-8" ?> 

<TemplateFiles> 

 <TemplateFile> 

  <Description>Our Letterhead</Description> 

  <FileName>Acme Letterhead.doc</FileName> 

  <DefaultFileName>New Letter.doc</DefaultFileName> 

  <MenuSection>Custom</MenuSection> 

 </TemplateFile> 

 <TemplateFile> 

  <Description>Our Legend Page</Description> 

  <FileName>Acme Legend.vsd</FileName> 

  <DefaultFileName>Acme Legend.vsd</DefaultFileName> 

  <MenuSection>Systems</MenuSection> 

  <FileType>Designer Suite Drawing</FileType>  

 </TemplateFile> 

</TemplateFiles> 

 

o The actual template files should also be stored in the Custom 

Templates folders. 

o The valid values for MenuSection are: Custom, Systems, Schedules and 

Blanks. 

o The FileType is only needed for Designer-specific file types, and can 

be: Designer Suite Drawing, Designer Suite Valve Schedule, Designer 

Suite Air Flow Schedule, etc. 

 

Release 3.1.357 

 

Design Module 

• The splash screen that appears when a Visio drawing is opened will 

automatically disappear after 15 seconds (allowing Visio errors to be seen). 

 

Core Module 

• An issue that caused Job and Customer Site nodes to show plain folder icons 

in the Project Tree has been resolved. 

• In the ADMIN�USER AND LICENSE MANAGEMENT tool, and Administrator can 

now change a user’s password. 
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Release 3.1.356 

 

Estimating 

• The new Customer Pricing (By System) report shows the total Sell Price for 

Material and Labor for each system 

• The new Labor Hours and Dollars (By System) report shows the total labor 

hours and dollars by system, fully inflated by the Global Labor Adjustments 

and the Labor Cost Escalations. 

• The new Schedule of Values Worksheet report creates a worksheet for 

assigning estimate Material, Labor and Subcontract cost to each system with 

adjustments for mobilization and various customizable weightings. 

 

 

Release 3.1.355 

 

Core Module 

• Checking in a project should now be considerably faster, especially when 

using a slower connection. 

• The start-up time for the application should be faster when using a slower 

connection. 

• In the Parts Database Manager, if you edited the Custom Labor Factors for a 

part the changes were not saved unless you did it twice.  This has been 

resolved. 

 

Design Module 

• The Bill of Material report has been upgraded from DS 2005 and is available 

on the main Reports tab. 

• The new Part Listing (Detailed Validation) report will show all the parts in a 

project along with validations, such as being in the database, Obsolete Date, 

Alternate/Replacement Part Number, Manufacturer and Vendor Part Number.  

(This replaces the DS 2005 Parts Found report). 

• The new Parts Database – Obsolete Parts reports shows all parts in the Parts 

Database that have been obsoleted, along with an Alternate Part Number if 

available. 

• The Bill of Material shape in the Page Add Ins stencil now allows you to 

optionally show the Manufacturer or Vendor Part Number (along with the 

Database Part Number). 

• The DS 2005 Tools menu in Visio when editing a Design drawing has been 

renamed to Design Tools. 

• There is a new Obsolete Parts error check available from the Design Tools 

menu in Visio. 

• Schneider Branch offices will see the Schneider Branch prices when browsing 

parts. 
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• In the project tree, the icons for System and Schedule folders may have 

reverted to the plain folder icon.  They will now show correctly. 

 

 

Release 3.1.354 

 

Core Module 

• When logged into a remote server, shortcuts to other projects now open 

properly. 

 

 

Release 3.1.353 

 

Core Module 

• You can create New Projects from Template Projects 

o To allow new projects to be created with a Template or Profile of pre-

defined folders and/or files, a server projects can now be designated as 

a New Project Template. 

o In the Open Project list, an administrator with the Set Project Group 

and Templates project permission can right-click on the server project 

and select ADMIN�MAKE PROJECT A NEW PROJECT TEMPLATE. 

o In the Open Project list, an administrator can check the new ONLY 

SHOW ‘NEW PROJECT’ TEMPLATE checkbox to filter the Server Project 

List to just the template projects. 

o When creating a New Project, you will be prompted with a PROJECT 

TO DUPLICATE list of the template projects of the selected project type.  

If you choose one of these templates, it will be duplicated to create the 

new project. 

 

Design Module 

• You can import an existing Designer Suite 2005 Project from the New/Open 

Project dialog. 

• The Relay shapes (Separable Relay and Pt-To-Pt Relay) have been upgraded 

with new filter selection properties and updated part and terminal wiring data 

in the Parts Database. 

• The general purpose Sensor shape in the Sensors & Transmitters stencil has 

been significantly updated to allow for more customization and flexibility.  

The part data for this shape, however, is not yet complete. 

• The properties for a Multi-File library, along with the selection and search 

forms, have been overhauled significantly. 

• Resolved a bug in the report engine that would generate data from the wrong 

set of files and/or systems. 
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Release 3.1.352 

 

Core Module 

• In the ADMIN�USER AND LICENSE MANAGEMENT utility, under VIEW 

LICENSES, there is a new button to Export the license list to Excel. 

• The SE Project Builder Help file is available from the Studio360 Help menu 

(if Project Builder is licensed for that workstation) 

• There is new Help menu command that will create an e-mail to the 

Company’s administrators for users to request permission changes, etc. 

 
Design Module 

• When browsing parts and accessories from a Visio part shape, there is a filter 

for “Show SE Strategic Parts Only” 

• The Multi-file Library dialogs have been enhanced, including the ability to 

compare multiple libraries on their distinctive properties. 

 

Estimate Module 

• A new format for “Workbook” reports allows a report to be embedded within 

a template workbook with additional worksheets. 

 
 

Release 3.1.351 

 

Core Module 

• The Admin�Server Configuration tool has shortcuts for downloading and 

installing Beta versions. 

• The Tools�Designer Suite�Remove DS Folder Prefixes menu item has been 

put back onto the folder nodes. 

 

Design Module 

• When new Designer/Design360 projects are created, they will now 

automatically have Systems and Schedules folders. 

• In the Table of Contents generator, when you edit an additional line item it 

will no longer offer to move the item to the top or bottom (which reordered 

the items unintentionally).  You can reorder items in the TOC by dragging and 

dropping them in the list. 

• When opening a Table of Contents file, you will be given the option to open it 

in Visio alone without the normal TOC functionality 

• If you close the TOC Visio file and click update, it will not reopen the Visio 

file. 
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Release 3.1.350 

 

Core Module 

• The Assign Permission Sets to Folders feature was not finding the correct 

matching folders.  This has been fixed. 

 

Estimate Module 

• When estimating a system, you can edit a part in the part list by right-clicking 

and selecting Edit. 

• There is a new report, Estimate Report Field List, which documents the 

various fields you can use in custom Booking reports. 

• When adding packages to a system, obsolete parts will be pointed out (and 

swapped out if alternate part is available). 

 

Parts Database 

• In the Parts Database Manager, the Export Existing Parts and Update Existing 

Parts are now available from the File menu. 

• When editing Parts in the Parts Database, you can override the Labor Factors 

and/or the Category used to determine Labor Factors for all parts. 

 

Design Module 

• The Valve selector will now show the images of the valve body and actuator 

when browsing from a Valve Schedule 

• The Controller Checkout report now shows custom Device Address properties 

based on the controller line in the header section 

• The System Point List report has been updated (from the Designer Suite 2005 

version) and included in the new Reports tab 

• The following SE issues have been resolved: 

o 93 – The Xenta From/To fields work properly 

 

 

Release 3.1.348 

• The following SE issues have been resolved: 

o 91 – The Continuum I/O Module utility will work properly with the 

AC-1 series. 

o If downloaded updated started too fast, could lead to a bad install state 

• The Reports/Design sub-folder is distributed from enterprise to server to 

workstation 

• The Part List button on the Accessories tab for new controllers and other 

shapes will now display all parts (instead of an error message). 
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Release 3.1.347 

• The Design360 Reports tab will work properly. 

• MNB-1000-15 was added to the Network Tree.  It can be put on a MNB-

1000’s new IO Bus. 

 

Release 3.1.346 

 

• The Release Notes document is now available on the Help Menu. 

• The Panel Device shape and the Automation Overview shapes have been redone, 

and moved to the Page Add Ins stencil. 

• The Design360 Reports have been upgraded and new reports created.  The older 

reports are still available (for the time being) on the “Reports (DS 2005)” tab. 

• The following SE issues have been resolved: 

o 45 – Resized the i2/b3-850, -851 and -853 to be 3” tall.  

o 46 – Resized the i2/b3-865 and -866 to be 4” tall. 

o 93 – Xenta 400s now all have a working LON bus, and the 527-NPR does not. 

o 113 – Xenta 500s and 913 have shorter wires off the left and right sides. 

o 115 – Ground Wires on Xenta 500s are now pointed to the right. 

o 117 – Xenta 511:B and 913 Modbus Note has been redone to not say the word 

“Note.” 

o 178 – Xenta 471 can now have I/O points connect to it. 

o 203 - Removed {} brackets around addresses in I/Net shapes. 

o 204 - Set the Maximum SCU Address to 30 when Address Mode is set to 

double. 

o 211 – Renumbered AOs to match controller for i2/b3/b4-920 and i2/b3-814. 

o 216 - i2/b3-810 and -814 DIP switches now support both kinds of current - 0-

5V, 0-10V. 

o 214 - Project Builder in Studio360: Project Builder was only supported with 

Excel 2003 and Visio 2003.  It will not work in Office 2010, and although it 

seems to work in Office 2007, we have had limited testing.  Please see Lonnie 

with any questions. 


